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The diagonal lines are instruments used to separate the headers representing different columns from each other. Unlike Microsoft Excel, there is no integrated function for creating diagonal lines in Google sheets. Therefore, we will improvise on some ways to insert diagonal lines in the cells. There are three known methods used to insert diagonals
into the cells and each method would be explained in detail to improve understanding. The sample worksheet below has no headers To indicate the data set in column A to column M. We would insert the diagonals in Al to separate the headers of each data set. Method 1: Insert a diagonal line using the tilt function. This function is used when you
want to split your cell into two parts. For example, if a cell contains two headers or titles and you want to separate them to represent the respective columns, the tilt function is used. Step 1: Select the row you want to dissect. Step 2: Press Alt + Enter simultaneously On the keyboard. This causes a break in the line between the two headers. Step 3:
Type multiple lines of the dashboard. Step 4: Press Alt + Enter new : Select cell A1.Step 7: Click the format on the toolbar. Go 8: Click Rotation. Pass 9: You can click the inclination option upward or inclination, depending on the direction you want the diagonal to do. 10: Click Inclined and produce results as shown below. Alternative: You have to
follow the previous step 6, then start 7 from Herestep 7: click the three horizontally arranged points on the toolbar 8: you can click The cell rotation icon on the toolbar. Styles 9: You can select the inclination option towardso tille down or click on the icon of grade to select the angle of inclination and the direction in which you want to face the
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visualization abilities, including A Aconditional formatting, Pivot Tables, SmartArt, graphs, and charts. Home and business users alike can create powerful spreadsheets and reports to track data and inform their decisions. One powerful Excel feature is Macro, little scripts and recordings you can create to make the program perform different actions
automatically. While no other spreadsheet program has this type of feature, it is complex and can pose difficulty for beginners. Excel also has close tie-ins with Microsoft Access, a database program, which can add power. In general, Excel integrates best with databases and any dataset requiring many calculations per workbook. When you first open
Excel in Office 365 or a newer version of Microsoft Office, you¢AAAIll see a basic screen. Here are the key features in this view: A.A ABasic App Functions: From left to right along this top green banner you¢AAAll find icons to: reopen the Create a Workbook page; save your work; undo the last action performed and display which actions were
recorded; redo a step that¢AAAs been undone; select which tools appear below. B. Ribbon:This grey area is called the Ribbon, and contains tools for entering, manipulating, and visualizing data. There are also tabs that focus on specific features. Home is selected by default; click on the Insert, Page Layout, Formulas, Data, Review, or View tab to
reveal a set of tools unique to each tab. We¢AAAIl cover this more in the ¢(AAANavigating the Ribbon¢AAA section later on. C. Spreadsheet Work Area: By default the work area is a grid. Along the top are column headers A through Z (and beyond), and along the left side are numbered row headers. Each  rectangle in the spreadsheet is called a cell,
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Microsoft Word. You can use use Tools to change the character, size and color of the words digit, and make them bold, Italian, or underlined. It also has a pair of leafy-specific formatting options. It is possible to choose which sides of the cell to obtain additional edges, and their style and thickness. It is also possible to change the highlight of the entire
cell. This is useful for creating captivating edges visually or differentiating lines or columns on large sheets, or to highlight a particular cell that you want to accentuate. C. Position formatting tools: Align the data of the cells at the top, below or in the middle of the cell. There is also an option for the insertion of the displayed values, which can
facilitate reading. The lower line has family options for left, central and right alignment. There are also the right and left buttons. D. Multi-cell formatting features: This section contains two very important functions that solve common problems for new Excel users. The first is the text of the envelope. Normally, when entering the text in a cell that
extends beyond the size of the cell, it is poured into the next cell. For example, if you type "cooked objects" in A1, some of the words "the enemies" are poured into B1. Then, if you type in B1, it covers all the characters of Al that extended to B1. The extra text of cell Al still exists, but now it is hidden. If you do not want to expand the cells, click the
icon of the icon of the envelope on Al - this is divided "budget objects" into two stacked lines instead of one inside Al. This makes the whole line higher to host the content. Now, typing in B1 do not cover the existing text. The other tool in this section is Merge and Center. There are instances when you can want to combine different cells and make
them act like a long cell. For example, you could An header for an entire table to be clear and easy to read. Select all the cells you want to combine, click UNIVE, then type the header and format it. Even if the default default al :annoloc alled enoizattamrof e gnidloH .3A e 2A ,1A ni artne is ehc 2Aic a esab ni Areibmac ehc ,ovitagen oremun nu = ossor
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id aicsaf anu eranoizeles id etnesnoc ehc ,muSotuA “A'c ,artsinis a otla'llad eritrap A :itnemurtS eiraV .H .inoizes enucla gnidihnu e interactive and incomplete. There is also a button for recommended pivottables, which can help when you don't know where to start. The table builds a simple table that includes any number of selected columns. Rather
rather placing the table elsewhere on the worksheet, it turns the data into a table on the spot, and applies customizable color formatting. B. This section lets you insert visual elements, like picture files, pre-built shapes, and SmartArt. You can add shapes and resize, recolor, and reposition them to create intuitive data sets and reports. SmartArt
objects are prebuilt diagrams that you can insert text and information into. They¢AAAre great for representing what the data says in another place on your workbook. C. These tools are for inserting elements from other Microsoft products, like Bing Maps, pre-built information cards about People (from Microsoft accounts only), and add-ins from their
store. D. Use these tools to create charts and graphs. Most of them work only if you select one or more data sets (numbers only, with words for headers or categories). Charts and graphs function like you¢AAAd expect - just select the data you want to visualize, then select your desired type of visual (bar charts, scatter plots, pie charts, or line graphs).
Creating one will bring up formatting options where you can change the color, labels, and more. E. Sparklines are more simplistic graphs that can fit in as little as one cell. You can place them next to data for a small, quick visual representation. F. Slicers are big lists of buttons that make your data more interactive. You can select a PivotTable

you¢AAAve created, and then create a slicer from it - this allows a viewer to click on buttons that correlate to the data they want to filter.A A G. This hyperlink tool allows you to make a cell or table into a clickable link. Once a viewer clicks on the affected cell(s), they¢AAAIl be taken to whatever website or intranet site you select. H. Recent versions of
Excel allow for better collaboration - insert comments on any cell or range of cells to add more context. You can open or close the comments so the worksheet doesn¢AAAt get too I. A text box is useful when you are creating a relationship and you don't want to write words to behave like cells. It makes it easy to move the text around, rather than
cutting and pasteing the cells (which could potentially fit the formatting of real data). The next area is for Headers & Footers, which brought you to the Layout display page - here you can add header and more page for the entire page. Wordart, on the other hand, allows you to embellish the text. Object insert allows you to insert entire files (Word
documents, pdf, etc.) in the work sheet. J. This section allows you to insert equations and symbols. Use equations to write a mathematical equation with fractions, variables and more that it is possible to insert in the sheet as a text box. For example, this can be useful to explain how a part of a table has been calculated in a relationship. The symbols,
on the other hand, can be inserted directly into the cells, and include all non -standard characters from most languages, as well as emojis. The page layout card has everything you need to change the structural parts of the work sheet, in particular for printing or presentation purposes. A. Use these buttons to quickly adjust the visual style of the entire
sheet. It is possible to adjust the fonts and colors, and use the themes section to apply it quickly to each table, pivottable and saglitart element for a clean and well -designed sheet. B. These are printing options. It is possible to change the margin for the print, if you want a vertical or horizontal printing alignment, which cells in the sheet you want to
print, where you want to interruptions in the page, and if you have a background (to insert the name of the company, for instance). You can also start giving each page a item using the titles button printing and the order to print each section. C. This allows you to choose how many pages and how many pages you want to print. Q. This section allows
you to activate if the automatic grids appear to work on the sheet and e Print it, together with the lines and column header (A, B, C, 1, 2, 3, etc.). The formulas memorize almost everything that concerns everything to the reputation of Excel as a "complex". Because because "because the complex". Because "because" because "because" because the
complex ". Because because" because the complex ". This article is intended for beginners, we do not cover every function is thoroughly this section. A. A. The Insert Function button is useful for those who do not know all the stenography. Cié raises a lateral formula section that describes every function and you can select what you want to use. B.
These buttons divide all the functions by category. The Autosum It works in the same way in the home card. Recently used is useful for making used formulas appear to save time to look through the menus. Financial includes everything that concerns everything that concerns the currency, values, amortization, yield, rate And more. Logic includes
conditional functions, such as a ¢ avelop "I if the text functions then Y. A cell (useful for post on Twitter), which combines two different lines via concatenate or extracting numerical values from V texts of text that are not formatted correctly. Like "TODAY", which enters the current date. The research and reference functions help to draw information
from different parts of your work folder to save you a € a € a € <Problem of looking for them. The functions of mathematics and trig are just like they sound, involving any type of mathematical discipline that you can imagine. More functions include statistical and engineering data. C. This section contains labeling options. If there is a range of cells or a
table to which it is often necessary to refer in the formulas, you can define its name and tag it here. For example, we suppose we have a column that contained the entire list of products you sell. Could The names in that list and define the name as "Productlist". Every time you want to refer to Column in a formula, you can simply type a €
ceproductlista € (instead of finding that collection of data again or memorizing their cellular positions). D. This contains errors control tools. With Trace Precedent and Trace Dependents, you can see which cells contain formulas that refer to a certain cell and vice versa. It shows the formulas reveals the formulas within all cells, rather than their
display values. Errors control automatically finds broken links and other problems with the calculation sheet. E. If you have a large sheet with a massive series of interconnected formulas, tables and cells, you can use this section to activate calculations, and also to choose which types of data are not performed. A good example is a mortgage or
patrimonial amortization sheet. The data card is for the execution of more complex data analysis that most beginners need. A. These are database import tools, which allows you to import data from any web, file or server-based database. B. This section allows you to correct database connections, update data and adjust your own properties. C. These
are the sort and filter options similar to those for the data you have inside the sheet, applied to data feeds. They are particularly crucial here as a database is sure to have more data of what you can or the care to use. D. These are data manipulation tools. It is possible to take a single long string, such as those separated by quotes or spaces, and divide
them into columns with column text. It is possible to search and remove duplicates, consolidate the cells and validate whether the data meet certain criteria to evaluate its accuracy. What-Iph Anaysis helps you to fill gaps with incomplete data using existing data and trends for orol orol al noc anungo ,elovehgeip elredner e ehgir o ennoloc id ammag
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eraerc rep elatotbus li erazzilitU .attehcite the zoom inside and outside the cells. D. The controls of the freezing box are an important part of the creation of a usable spreadsheet. Using these tools, you can freeze a series of lines and/or columns while it flows. For example, if the first line had all the column header and remained frozen, frozen, Always
know which column you're looking at while you're going down. E. Macros are a way to automate processes in Excel. It is well beyond Excel 101, however. Now that you learned about Excel tools, we practice doing our spreadsheet from scratch. This guide will cover the basics, with some intermediate techniques to make you more comfortable with the
spreadsheets. Step 1: Create a workbook & When you open Excel, you will be presented a screen like this. Create a new workbook by clicking the new tab on the sidebar. The recent tab below that will make appear all the workbooks you recently opened. Below is the shared tab, which shows the workbooks that other Excel users sent you directly
through the app (we don't focus right now). The final tab is open, which opens a file browser so you can select an existing workbook. In the new tab, you can see a number of models available, which can help you jump directly to realize specific types of spreadsheets, such as budgets and task lists. In this example, however, we build from scratch a
spreadsheet. Click Blank Workbook in the upper left corner, and then click Create. Step 2: plan the necessary data before you can create any type of spreadsheet, you need to plan what it will include so you can structure it and format it accordingly. Although it is possible to change the structure of the spreadsheet later, the more data you added, the
more it becomes uncomfortable. Moreover, moving around entire files and columns increases the chances of accidentally changing formulas. In this example, we are making a monthly budget, so we will use a monthly time stamp. As we explored above, we can use other sheets inworkbook to track other time increments, such as weeks or years. Of
course we want to add all our different expenses together, but we should also think about categories for comparison. We may have one for need and one for We¢AAAIll need subtotal rows, along with a comparison of budget to actual spending. At the end, we¢AAAll also want to easily compare the different parts of the budget together. Now we know
the elements we need, and can organize them accordingly. Step 3: Create Headings Since we know we want to compare month to month, we should use months as our column headings - horizontally is usually best for time comparison. Since we know we¢AAAll also have categories of spending to label and sublabel, we should leave the A and B
columns open, and start at cell C1.A A A A Here¢AAAs a useful trick: if you type a number or timestamp with a logical next entry, you can click the lower right corner of that cell and drag in any direction to autofill the rest of the sequence as far as you want. For this example, after typing ¢AAAJanuary¢AAA in C1, you can drag it across to N1 and
watch it fill in the rest of the months. To create the diagonal names in the screenshot, navigate to the Home tab and find and click the formatting option with a diagonal rising appearance. This makes the headings stand out without changing the column width. We¢AAAIl also need an area on the sheet where we can get row totals for more useful data,
so create the heading Total in cell O1.A A Step 4: Label the Rows Create three blocks of entries on column B. Name the first block Necessities, which will include everything you see, and end with a subtotal. Name the second block Luxuries and include a few categories; also end with a subtotal. The last block will have our Total, the budget to compare
it to, and the difference between the two, which we¢AAAll call Saved (this amount represents the difference between the expected and actual spent). To makes them stand out, use the Paint Bucket tool and select a color (grey in this example). For column A, we¢AAAll create labels that clearly line up with our grey blocks, and position the writing
vertically so it doesn¢AAAt take too much To make the column width smaller, grab the right edge of column A and drag it to the left. To combine all cells for our category labels, highlight A2 through A7, and Merge & Center. To get vertical writing, switch to Home tab, find formatting option and click vertical writing. Finally, choose the alignment of
the height as centered so that the vertical text will appear in the middle. Repeat this with A9 cells through A13. Step 5: Add comments Add boundaries to the spreadsheet using the icon in the graphics above. Select each collection of cells and do not adjust the spaces between gray blocks groups. Click All borders to draw distinct grids. Now, make the
outer boundary of each block more often by selecting the entire area and choosing Thick Box Border. Finally, do the same around the inner row of each Subtotal labeled box, to make these visually distinct. Apply a Thick Box Border to column O, Total and leave spaces between each row group. All this improves the legibility of the spreadsheet. Step 6:
Create a result table Use the well formed spreadsheet side to create the contours of a simple table that will contain the main results. This information will help you create a chart later. Give him an appropriate label, and label his lines for the total from Necessities, the total from Luxuries, and the total Saved for the year. Step 7: Format and Write
Formulas This is where the spreadsheet gets much more powerful. This is a series of steps: A. First, select each cell that will contain a number, under C columns through O, and also in the table for Budget portion. Now click on the “$” on the keyboard to format the cells with the standard dollar format withdecimal for cents. B. Select the C2 cells via
C7 and click Autosum. This creates a formula that adds everything in this column and inserts the sum in C7 (the last selected cell). C. use your yours To grab the bottom right corner of the cell C7 and drag it right to column O. This will duplize the formula along the entire subtotal line. This means that while C7 = sum from C2 to C6, d7 = sum from D2
to d6 and so on. Repeat the process for mourning. Q. For the total area, budget and saved, the process is a little different. Click the cell C15 and enter this formula: =C7+C13. This is the two subtotals. As you did with other formulas, drag it and duplicate it through column O. & F. Click Cell C17 and enter this formula: =C16-C15. This will make the
saved line equal to the difference between budget and total. E. Finally, add formulas to each blank cell of your part of the budget table. Q3 = O7, which will bring the annual subtotal of all necessities in the part of this table. Do the same for the subtotal annual lumps table and the annual total saved. FASE 8: Conditional script formatting Before
entering data, there is another configuration bit: conditional formatting. To do this, click the drop-down arrow on conditional formatting and click Manage Rules. Then, click + to add a rule, which leads you to a new pop-up menu. Click the style: Classic. Then choose only the cells that contain and click the cell value greater than 0. Format this with a
standard option, green fill with dark green text. Now you will be returned to the Manage Rules section, where you can select which cell range you apply. Choose from C17 to O17 to make it affect only the saved line. Now repeat steps, but this time format only cells that contain the cell value equal to or below 0. Use red filling standard option with
dark red text and Apply it to the same range of cells. Now you have a conditional format for all voices of thesave calculated finals. If it is greater than 0, it becomes marked green and if it is O or less, it is marked in red. When your data is entered, you can see in which months you saved money and you didn't. Step 9: Enter the data and watch the
Calculations First, enter into a budget assumed, and copy it through the budget line dragging it from its bottom right corner. In this case, the budget assumed is $3,000.00. Subsequently, enter your data for each month of last year, totaled by receipts and bank statements, and classified accordingly. Now, for the magic of spreadsheets: as you insert
every bit of data, you will see your Total, Save files that fill up, as well as the Portion of Budget table - all calculating and updating in real time. Step 10: Create a Pie chart Create a simple view. Select the entire Portion of Budget table, then click the Insert tab on the tape and choose Chart cake. Because of how the table is set, the chart will be titled
Portion of Budget, and each dollar amount will appear as a percent of the pie chart with the label necessary. Do not forget to click Save at the top left of the Excel app. Now you have an incredibly useful spreadsheet that tells you exactly how well you stuck to your budget every month while also getting a sense of where your money went last year
overall. You can copy and use this spreadsheet year after year. If you want more help to start creating a budget, check the top Excel budget templates. Also, increase speed with this complete list of keyboard shortcuts in Microsoft Excel. Discover all the basics to make a spreadsheet with Microsoft Word. Word is the most popular word processing
application in the world, with countless ways to format text-based documents, but also with simple tables and spreadsheets. Like Excel, the application comes as part enoizatigid enoizatigid al rep enoizacilppa'nu am ,oloclac id oilgof enoizacilppa'nu orevvad I A non droW ,ittafnl .563 eciffO ni elibinopsid droW tfosorciM id enoisrev al azzilitu lairotut
otseuQ .caM e CP rep inoisrev ah e ,563 eciffO e eciffO tfosorciM Distribute text documents. It is much easier to format phrases and paragraphs in words than in text boxes available in Excel, not to mention cells inside. For this reason, the word can be used to create convincing reports or to insert semi-mixed data into a heavy text document, such as
an article. Word has two methods of creating spreadsheets: create simple tables in the program itself or Inserting sheets and charts from Excel. Unlike Excel, where everything in the tape is essential to create a spreadsheet, only a few items are relevant in Word. To begin with, almost everything you need is in the Insert tab. Here are the tools of the
relevant Insert tab: A. Table: Click this button to create basic tables in some ways. When you click on the table, a grid is displayed that you can pass and click to choose the number of vertical and horizontal cells you want for your spreadsheet. If you click Insert Table, you get a pop-up window that lets you specify the size of the spreadsheet by typing
the number of rows and columns for the table as well as setting the width of the cells. Finally, you can select Draw the table to drag and create all the cells you want. Despite how simple it is, the drawing table is not actually the best or easiest way to create a spreadsheet in word. B. Chart: A drop-down menu appears when you click this button which
has the same types and styles of graphs - and even the same interface - of Excel. You will see scatter charts, pie charts, lines charts and more. C. Design and layout of the table: when you click any table in Word document, two additional tabs are displayed at the center of the tape. Both tabsOnly for the tables and contain further tape menus explained
below. D. Object: It is possible to bring Excel elements directly to your Word document. Insert a Microsoft Excel graphic or a Microsoft Excel work sheet. Select one of these options open Excel so you can create and e a fully functional spreadsheet that will appear as-is in Word document. These spreadsheets and charts behave as images in Word, so
you can move and resize them, and also double-click them to open Excel and update their data. You can also insert an existing Excel file. To do this, click From File, then move to Excel file location and open it. Initially, only the primary sheet appears, but double-click it to allow anyone to access the entire workbook unless it protects it. Let's focus on
Table Design. These options are only for tables created within Word, not those imported from Excel. E. Use these keys to choose some table layout elements such as column, row or header color. F. These are the style presents very similar to table styles in Excel, with a wide range of colors and varieties. In addition, with the Paint Bucket icon, you can
customize the shading rather than choose one from the drop-down menu. G. These tools allow you to design the edges of each single cell, and the whole table. You can choose thickness, color and type of line (dotted, right, corrugated, etc.). So let's take a look at the Layout tab. Again, this only works for tables created in Word. H. Use these tools to
select rows and choose whether to show or not network lines. You can also open the Properties window and edit various items, alignment of the table, or as the edges and shading appear. Me. This is another home for the Drawing table and Clear table tools. Use these tools to drag the mouse and draw each cell and delete them, one side at a time. J.
These are tools to delete rows, columns or whole tables. You can alsohighlighting a cell, by clicking with the right mouse button and selecting to delete these portions. K. Insert lines or columns where you like in your table with these tools. Once again, you can access these tools by highlighting and clicking with the right mouse button on different
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Chart button to access this feature. Once you choose a style, it will open Excel so you can change the chart data. The functionality works exactly as in the Excel tutorial above. However, once the chart is in Word, two new tabs in the tape, instead of Table Design and layout. They become Graphic Design and Format. A. Use these tools to add extra
important elements to the chart, either individually with Add Chart Element, or all at once using the useful presets with Quick Layout. B. Use these tools to adjust the chart style without changing its layout too. You can adjust colors, fall shadows, background and more. C. Manipulate data in the chart with this set of tools. Line/Column Switch allows
you to change the X-Y axes of the chart. Select Data reports you to the Excel session to choose the set of data you want to represent in the chart. Edit data in Excel allows you to change anything you like data in Excel. You can also go to Excel by double clicking the chart. When you return to Word, click Update Data to update the chart to reflect any
changes made to data in Excel. D. Change table The type allows you to switch from a pie chart to a line chart and so on, using the same data set. Now look at the Format tab. E. The selector tool allows you to choose which part of the chart you would like to edit so that you do not accidentally click elsewhere. You can select the Trama Area where the
chart is stored, the Graphic Area where all axis labels exist, or any other element. F. Use this to insert shapes into the chart, just like inserting any other object in Word. G. Use these toolscolor each item on the chart, which can include how you want to fill lines, text color and more. h. These are all style options for text in charts that manage adding
wordart, a fill color and more. I. Positioning tools workto the positioning of other objects in word. You can make the text by wrapping the chart with the wrapping text and place it behind or in front of any other element on the page. J. Use these tools to change the height and width of the entire chart numerically. You can also adjust the height and
width of the chart by grasping the angle or side and adjusting it with the mouse. K. This opens the format pane, which has some of the same tools found in the tape, but are larger and easier to access some. Now that you have learned about spreadsheet tools in Word, you can practice some different ways to import an existing spreadsheet in Word.
Step 1: Create a Word document When you open the word, this screen appears. The new tab on the left side allows you to create a new document, recent surfaces have recently opened documents, shared shows documents that other Word users sent you and APER, you can see a series of models that you can use to jump directly into creating different
types of documents such as resumes, blogs and research documents. Most do not refer to the spreadsheets at all, then click the blank document in the top left corner, and then click Create. Step 2: Save the document once you create the document, save it by clicking the Save icon shown above and select a location to save it. Give him a relevant name
for his purpose, so it's easy to find. Step 3: Import an Excel workbook into the document, go to the Insert tab, and click the object. When the Popup Insert Subject window appears, click Microsoft Excel, and then click the file. This opens a file browser window, where you can select the simple budget spreadsheet created infor example. Open it. It's
passage 4: resize the spreadsheet to adapt to a sheet of calculation as big as what we have created is too large for a standard word document to its normal size. To reduce it, click once on the spreadsheet, spreadsheet, and hold down the Shift key. While pressing Shift, select a corner of the spreadsheet and drag it towards the center of the object a
few times. It¢AAAs important to note that spreadsheets behave like a regular picture or object in Word, so you can drag them around and change their size as you like. Feel free to add text below the spreadsheet, as well. Regardless of the spreadsheet¢AAAs size, you cannot interact with the data within Word. However, all of your formulas and
formatting will remain intact. You can still work with the rest of the document, typing words and inserting pictures around the spreadsheet.A Step 5: Edit the Data in Excel To edit the data, double-click the spreadsheet to open the spreadsheet in a new Excel window. Here, you can edit any data. It updates in real-time, meaning that as soon as you
make the change in Excel, the change will be reflected in Word. In this way, you can bring fully-functional spreadsheets straight into Word. A Note: When you double-click on an inserted object like an Excel workbook, you have access to the entire workbook, not just the first sheet which appears as an object in Word. If you are sharing a document like
this with someone and don¢AAAt want them to access other sheets, make sure to enable Protect Sheet in Excel. The newer version of Word lets you simply copy and paste cells and other Excel elements from an Excel workbook into a Word document. Here¢AAAs how to do it: A Step 1: Open Your Excel File Open the Simple Budget workbook that
contains your table, chart, and spreadsheet in Excel. A Step 2: Select and Copy a Range of Cells, a Table, or a Chart Highlight cells in the budget spreadsheet, then press Ctrl+C to copy the data. Alternatively, you can single-click the Portion of Budget chart, and press Ctrl+C to copy it. A Step 3: Open Your Word Document and Paste the Selected
Cells or ChartA In your Word document, right-click on your mouse and click To paste your chart and contents of the selected Excel worksheet into your Word document, one at a time. (Please note that for this example, we do not cover the entire spreadsheet.) You will notice that a cell formatting is lost; This is because data enters words and behaves
like a table created in Word, rather than as Excel spreadsheet. Step 4: Format your data charts in Word behave a lot like graphs in Excel. When you single-click a chart to select it, it opens the chart design and format tabs so you can manipulate information (e.g. design and layout). If you need to change some of the chart data, click Edit Data in Excel
on the All-In-One Bar. You can also switch the mouse over areas of this pie chart to emerge further information such as the number of dollars that the blue portion represents. On the contrary, spreadsheets and tables do not behave equally in words, because the capabilities of the Word table are much more limited. Much of the formatting as it is kept
intact, but you lose almost all formulas. For example, note that the months in the header are no longer angled to 45 degrees upward. If you click the Formula button while keeping the cursor in any cell, the formula that the cell contains should appear. The January subtotal by necessity claims to have the formula = sum (surface), which means that this
cell is the sum of each cell with numbers above it. However, this is not true: the modification of the cells above will not update the numbers. You can return to this formula and enter the new sum, but it will treat the rest of the text within this cell as only text, stringing the new sum with it. The conclusion? Copy tables directly from Excel can be a quick
way to put avisual in word. However, it is not useful if you need to update the data for the formulas. The graphs, however, are good to copy and paste in Word, since they are still modifiable in Excel with their full functionality. Step 1: Create e e e ,tnemucod gnikrow that stnele tsujda tsujda tsujda tsujda tsujda tsujda tsujda ot ot era€aF¢C€ Retne ot ot
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siht .drawn the gnivom dna tcejbo fo renroc eht gnikccilc yb trahc eht fo ezis eht EHT the left or right edge of a cell and dragging it as you see fit. A Step 5: Apply styles to visually appeal the program, apply fast style presets. Click on the Home tab. Select the whole table, then choose a preset you like from the tape. Since you have a header line, make
sure you choose a style that makes it visually distinct. Now you have a simple, well-designed table that you can use for daily planning. To extend it and add other items to the list of things to do, click a row and then right-click and choose Insert: rows below. A See a complete list of keyboard shortcuts in Microsoft Word. This section will cover all basics
to work with Google sheets. Google Sheets is a spreadsheet app that lives in the cloud, which means you never have to download anything and can update the sheets from any computer or smartphone. In particular, it is free: anyone with a Google/Gmail account can access all its features. Google sheets are not as robust as Excel in terms of
functionality. It has less formula functions, a set of tools less accessible and you can not set any automation macros. What Google sheets have, however, is quite good for basic users: real-time collaboration skills. This means that you can share a sheet with other Google users, collaborate with them on the same spreadsheet and see the changes and
comments instantly. Instant data insights and also generates graphs, tables and automatic graphics to be inserted in a document. A Sheets integrates with all other Google products, allowing you to automatically enter Google Forms data. The sheets you create will be saved on your Google Drive account and you can enter .otoF .otoF elgooG ni iah ehc
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cisab era era eraht .a .teehs eroot teehsdaerps olt olt olno limnot Nobbir Elbairav evah ta€a€a¢mnSEOD Elgoog ,Scudorp tfosorcim ekilnu .Selbat Ro Text to overflow in the next cell, wrap downwards and increase the height of the cell, or a € ceClliccaa € the text when it starts to overflow. (The text is still there, it is only hidden.) The final button in
this area allows you to angular the text in a different way, as in Excel. H. These are tools that work for superior purposes. The first allows you to make a cell or a cell interval links to a website or file. The second is the commentary options - just highlight a cell range and click it to comment. Others can also respond to your comments. Next is inserted
graphics, which brings a popup window quite robust with numerous data display options. There are more types found in Excel, but there are fewer styles than each. In addition to the line graphics, bar and cake, there are maps that light up according to the position data that includes, organs for companies, radar graphics and Venn diagrams, to name
a few. The next icon is for selection and filtering, which allows you to insert the filters menus on top of each column that can be updated and modified in real time. The final icon is the drop -down menu of the main formula. It shows only some functions by default - Sum, Averal, Count, Min, Max. The rest of the functions are hidden in more functions,
which raises a new page that has just a list of functions. The formula The bar also has an automatic completion function: starting to type & € ce = a € and a pair of letters to reveal a list of functions with those letters to select and insert in the formula. All other tools are hidden in the drop -down menus, which are covered below. Files and edits contain
basic functions to download, share, cancel and redo. The Edit menu also has and replaced, which allows you to scan the document for any cell containing search criteria. View menu: Freeze: This submenu contains everything necessary to freeze the panes. You can freeze any number of columns and rows you like, so you needgnivael ,gnittamrof lla
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syates Naked cells with only their content and/or values displayed. Data Menu: Order: The selection options are redundant with the selection tools on the main toolbar. These add ranges that you can order inside. Protected leaves and blades: This allows you to choose some cells or sheets you want to prevent people from changing. PivotTable: These
PivotTables work as they do in Excel: select a data group with at least two columns and create reports. The editor report appears on the side, allowing you to choose which data you want to group in rows, columns and which values and filters to use. Data validation: For more complex sheets, this feature can find missing errors and data for you to
correct. Menu Tools: Create a form: This launches a Google Form creation window, automatically linked to your Google Sheet. When the user has entered this on websites or sending it by email, all the response data will be transmitted in the sheet. Script Editor: This allows you to write custom features and scripts to automate and extend the
capabilities of Google Sheets. This function is only for advanced users. Autocomplete: A useful setting that allows Google Sheets to use what it learns to fill the information. It is recommended to keep this. Protect sheet: This allows you to protect the parts or all the sheet so that only the right people you shared with can access it. Personal Dictionary:
This is every word your Google account has been said is a properly rejected word that does not exist in its main dictionary. Form menu: This menu only has some redundant features on Google Forms. Add-Ons: This menu has links to Google Sheets add-on marketplace. These are mostly non-official extensions than several developersCreated to make
Google Sheets more useful. They do not always work correctly, and are not recommended for elementary users. Now that you know all Google Sheets tools, practice doing your calculation calculation sheet JEsu lla€a€a€a€a€a€TR, Ehnerefer eht Fo nmuloc HCAE ROF Seman Etaerc .B €ati €ati .Teehsdaerps ruoy gniman yb trats .a elbat ecnerefer
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2B=4 icsiresnl .2D allec allus cilc eraf ,otseuq eraerc reP .osrevid ottiforp id enigram nu Arva onungo —Asoc ,errudorp rep ossets ol onatsoc ittut am ,ilibairav izzerp onnaH .etnemavittepsir ,CA e ,3A ,2A ellec ella erettel ilat eregnuiggA .C e B ,A onnaras ittodorp I .C .tinU/tiforP e , AtinU/otsoC , AtinU/ozzerP Make business in the form of taxes, which
would also reduce the final profit. You will need dedicated columns to monitor this information, then type & € cePaese Customera € in cell 7f, 4 € a emocncn eht tamroF ! ! F nmuloc, sredaeh nmuloc ruo gniretne retfa taht eton osl column by highlighting the cells and clicking the % button on the toolbar. Add the currency format to the Final Profit
column by highlighting it¢AAAs cells and clicking the $ format button.A A A A Now, use the basic AutoSum formula to place totals counts for each of the quantity columns, for the Profit from Sale column, and the Final Profit column. Highlight B8 through B17, then click the Formula button on the toolbar, and click SUM. The total sum will appear in
B18. Now drag this cell¢AAAs formula to C18 and D18, then copy and paste it into H18.A A A A Step 7: Add Styling Add styling to your table to help make it more readable. Click and highlight all the cells in the table (excluding the totals). Then click the Format menu and click Alternating Colors in the drop-down menu. Then click a Formatting Style
from the sidebar to apply a style to your table. Click the blue Done button. A A Next, click and highlight the cells containing totals totals, and click the Fill Color icon on the toolbar and choose a color. Quantity totals might have the same color as the product reference table above. Totals relating to money might be green. Adding color elements to help
with quick visual reference is a plus.A A A A Step 8: Enter DataA A Now enter data for all your table¢AAAs quantities sold for every product in every sale, and the A Abuyer¢AAAs country. Feel free to use the data in the screenshot above. You¢AAAIl notice all the calculations are done automatically. A A Step 9: Sort by Country Let¢AAAs learn about
sorting. To create a table for map data, we have to have totals by country. It¢AAAll be easier to gather this data if we sort it by that criteria. You want to be sure when sorting that you don¢AAAt cause any rows to become disassembled - data has to remain together to be useful. A A Select A7 through H17 (this is the entire table except the totals). Now
open the Data menu, click Sort range, and then tick the Data has header row box. (It Reorganize the headers, just under them.) Then choose the country of the column customer from the menu by menu, passing from to z. Now your data is organized by country. Now use the same steps described above to create a table with Only the country of the
also add a style to it if you want it. Step 10 Analyze data with Explore - Now that you have your data represented to answer all your questions, it is time to start analyzing them. It is 1mportant to remember that on a real sheet of sale, you probably would have hundreds of sales, not 10, so computer—a551sted analysis would be really advantageous Click
the Explore icon in the bottom right corner of your Screen to open the sidebar of exploration. As you can see from GIF, there are countless ways to analyze data by selecting a table or the other and exploring the graphs and graphs created automatically. You can also highlight all cells in a table and click the table. Now you have a sales tracker working
with useful data analysis ready to go. Here is a complete list of keyboard shortcuts in Google sheets. This section will cover all the basics you need to know about work with SmartSheet, an automation platform and process inspired by the spreadsheet that you can use to create powerful and collaborative spreadsheets. It is a cloud-based application, so
you never need to download anything and can be upgraded from any computer or smartphone and stays synced on alllt is available on any platform with a web browser and you can share spreadsheets with anyone. SmartSheet has many, though not all, functions Excel hasa collaborative environment in real time. This that makes Smartsheet unique is
that the spreadsheets, known as Grid View, are only the base below for the app skills. With Smartsheet you can assign unique properties to each column that affects its behavior in different types of visualization. For example, if you have a column given, you can view your data on the View calendar, where each line becomes an element on a calendar.
If you give each line an start date and the end date column, you can use Gantt View to see where the temporal lines overlap from the element to the element. If you give your lines a column to descent list, you can use Card View to see the elements as cards that you can drag and release from one section to another, to indicate the category or the state.
Another unique feature of Smartsheet is that not everyone needs to buy the app to access it. A paid user can invite internal and external collaborators to a sheet, which can all collaborate on the sheet in real time. It is possible to practice by making your own sheet of calculation of the project tracker from scratch to Smartsheet. This guide cover the
foundations and many of the unique features of the app to quickly produce a powerful collaborative calculation sheet. Step 1: Create a new sheet and name on the SmartSheet homepage, click Create and choose Grille to start. In the popup window, appoint the & € & € ceNuova project sheet.a € step 2: appoint the primary column and enter the data
starts by changing the name of your primary column to a € ceTask Namea €. Click on the cell with the words primary column to rename it in the pop-up window that appears on the screen. Click the Blue button ok. Enter a couple of activities in the column relating to Cié you like. Step 3: Create a contact column now change the name of Colonna2 a a.”
Click the cell with the words Colonna?2 to rename it in the pop-up window that appears on the screen. Then, click the property of the Contact List column. Click Ok. Now you can start id etad ella esab ni onognopparvos is Ativitta el emoc eredev rep e ,eroirepus enoizagivan id arrab allad weiV ttnaG eranoizeles ,euD e tratS ennoloc ellen Ativitta ingo
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Look at the view of the card with the card see, you can view all your lines of activities for internships, because it is a criterion in your descent list. This is a quick visual way to see how e draobhsad i ,pu-llor id troper i noc edacca otnauq ni oroval len elaer opmet ni Atilibisiv al ineitto e evaihc ehcirtem us alangeS .ottaf *Aip id erenetto e ecaciffe *Aip
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